Scratch Part 3
Lesson Objective
This lesson teaches some techniques for creating engaging and fun games. We will build on what we learned in Scratch 1 and Scratch 2 and talk about prefabs, clones, game loops, block parameters, random numbers, graphic effects, collision detection, and more!

Introduction
Show the kids a copy of what they are going to build. Explain the concepts they will learn:
1. Prefabs
2. Clones
3. Game Loops
4. Block Parameters
5. Random Numbers
6. Graphic Effects

Step 1 – Getting Things Setup
For now we just want to get the appropriate background and sprites into place. 
1. Let's start with the background. Click on the Stage and then on the Backdrops tab.
a. Click the Choose Backdrop from Library button.
b. Under the category Outdoors you will find the background night city.
2. Now let's add Scratch. Click the choose sprite from library button.
a. Select the section Animals.
b. Select Cat1 Flying.
c. Remove the existing Scratch by right clicking -> delete.
d. He is a little too big on the screen, so use the shrink button on the top to make him a bit smaller.
3. Next let's add the sprite for our Heat-Seeking Ampathought! Click the choose sprite from library button.
a. Under the category Things, you will find the sprite Paddle.
b. Once you have the paddle, let's make edit the sprite a little bit to make it a little less long.
4. Last, but not least we need to add our adversary!
a. Click on the choose sprite from library button.
b. Select the category Fantasy.
c. Select the Dragon.
d. Once the dragon is imported, he needs a little bit of fixup. He is facing the wrong way! 
i. Click on the Costumes tab and click the flip left-right () button.
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ii. Do this for both costumes
Now we should have all of the main sprites we need for our game!


Step 2 – Moving our Hero
The first thing to do to make Scratchy a super hero is to make him fly! To do this we're going to create what's called a Game Loop. A game loop is simply a repeated set of instructions that happen while the game is running. They include doing things like updating a sprites position so when the graphics are drawn their placement is updated. Almost every game has one of these loops.
1. Make sure the Scratchy sprite is selected.
2. Add a when (flag) clicked block from the Events tab.
3. Let's snap in a repeat until block from the Control tab.
4. Since this is our main game loop, we're going to be repeating as long as the game is running. To know if that is so, we need a variable. Click on the Data tab and create a variable named GameOver with the for all sprites option selected.
5. We're going to want to initialize the variable each time the user plays. The best place to do this is right above the main game loop. Grab a set GameOver to 0 block and snap it right before the repeat until block.
6. We're going to want our game loop to run as long as the value of GameOver is zero. While we're still in the Data tab, grab an instance of the GameOver variable and pull it onto your scripts plane. 
7. This variable block will not snap into the repeat until block until we make it a comparison. Go to the Operators tab and select the = block. 
8. Snap one side of the GameOver block into the left side of the = block.
9. Type 0 into the other side of the = block.

We want to keep our game look as small as possible so any action we do inside of the game loop should happen in a custom-defined block. Let's make these custom blocks now.
1. Click on the More Blocks tab.
2. Click the Make a Block button.
3. Name the block Shoot
4. Create blocks named Hit and Die the same way as above.
5. Now we need to create one more custom block. This one is named Fly, but it will need a couple of parameters. We do this by expanding the Options on New Block dialog. The first parameter is a number input and will be named XDistance.
6. The second parameter is also a number input and will be named YDistance.
7. Click Ok to finish creating the custom block.
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Now that we have our custom blocks, let's complete our Game Loop!
1. Add 5 if/then blocks from the Control tab into our main game loop.
2. The firs tone will have the Shoot custom block found under More Blocks. 
3. The other 4 will have the Fly custom block.
4. When the game is over, we want our Die script to run, so place that below the main game loop.
5. Our if/then statements are still incomplete. They need key pressed events. Click on the Sensing tab and add key space is pressed? blocks to each if then block.
6. Now change the keys to space, right arrow, left arrow, up arrow, down arrow going from top to bottom.
7. We need to set the correct values for our Fly block. Because we fall faster than we can climb, and we can slow down faster than we can speed up, we're going to use values which make Scratchy move faster in some directions than in others. This will give more of a real-life effect. Therefore, the numbers we're going to use are:
a. right arrow: 30, 0
b. left arrow: -60, 0
c. up arrow: 0, 30
d. down arrow: 0, -60
The last thing we need to do to make Scratchy take flight is add some actions to our custom Fly block.
1. Under the Motion tab, snap a glide 1 secs to x: -154 y: 13 block into our custom Fly block.
2. Go to the Operations tab and put two 0 + 0 blocks into the x position and y position of our glide block.
3. Go back to the Motion tab, and put x position as the first parameter on our glide x: + block and y position as the first parameter on our glide y: + block.
4. Now grab the XDistance parameter inside of our custom defined Fly box and drag it to the second x: + parameter. 
5. Do the same for YParameter to the second y: + parameter.
6. Set the seconds on the glide block to 0.2 secs.
7. The block should now read: glide 0.2 secs to x: (x position + XDistance) y: y (position + YDistance)
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Let's give this a test! Click the flag and see if you can control Scratchy! You'll notice that he doesn't really look like he is flying, so let's fix that. 
1. Open the Events tab and grab another when (flag) clicked block.
2. Add a Forever block from the Control tab.
3. Add 2 wait 1 secs blocks inside of the forever block. Change their values to 0.5 and 0.4 secs.
4. Open the Motion tab and add 2 change y by 10 blocks in between the two wait blocks. Change their value to -2 and 2.
If we followed the instructions correctly, we should end up with this:
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Step 3 – Heat-Seeking Ampathought
Now that Scratchy can move around the screen, we need to give him his main weapon! Of course he needs to be able to shoot more than just one beam! We could create a bunch of sprites and use them in turn, but there is a better way. 
That way is cloning Prefabs. A Prefab is a sprite that serves as a model for other sprites that we're going to create based off of that sprite; this is called cloning. When a sprite / Prefab is cloned, all of it's properties are copied exactly as they are to the cloned object.
So using a Prefab for the ampathought beam allows us to model it once, but clone it as many times as needed. We can make as many clones as we want (within reason) and the clones can be created and destroyed easily. 
One inelegant part of this is that we want the beam to appear to be coming from Scratchy's eyes, and the location (X and Y coordinates) of Scratchy aren't available to the ampathought beam. The only way we're going to be able to get this data over to the beam is by creating some global variables and updating them with Scratchy's position.
Let's start there:
1. Click on the Data tab and click the Make a Variable button. Name it ScratchyX. Make sure For all sprites is selected.
2. Do the same for another variable named ScratchyY.
3. Uncheck the checkbox all game variables (this removes them from the screen)
4. Add 2 set ScratchY to 0 blocks to the bottom of our game loop.
5. Change one of the set blocks to ScratchyX.
6. Click the Motion tab and select the x position box and drop it on the set ScratchyX to (x position) block.
7. Now do the same for the y position bock.

Now those variables will have the up-to-date position of Scratchy. Now we need to create a clone of our beam and let it travel across the screen.
1. Click the Control tab and drag the create clone of myself block under the Shoot custom block. Change the dropdown to Paddle.
2. We want Scratchy to be on top of the beam, so we need to add a go to front block from the Looks tab.
Our Shoot script should look like this:
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Now that we have Scratchy creating the clones from the Prefab of Paddle, we need to attach some logic to the Paddle sprite to tell it what to do once cloned. 
1. Click on the Paddle sprite.
2. Under the Control tab, select the when I start as a clone block and pull it onto the script area for the Paddle.
3. We now want to position the beam to Scratchy's position, plus a little to make it look like it's coming from his eyes. In the Motion tab, grab a go to x: ( ) y: ( ) block and snap it to the when I start as a clone block.
4. Head to the Operators tab and grab a ( ) + ( ) block, and snap it to the x parameter of the go to x: ( ) y: ( ) block.
5. Now head to the Data tab. Snap ScratchX to the x parameter.
6. Snap a ScratchY block into the y parameter first parameter of the ( ) + ( ) block.
7. For the other value of the ( ) + ( ) block, add the value 10. Note: this value may be a little different depending on how large or small you scaled the Scratchy character in the beginning.

These beams look a lot neater when they have a ghost effect applied. You can also apply a color effect to make them a color of your choosing. This is optional, but these graphics effects cab be found in the Looks tab using the set ghost effect to 25 block; changing the dropdowns to ghost and color.
The number one rule about clones is that they MUST be destroyed at some point, and before you have a ton of them on the screen. A lot of sprites on the screen at the same time is a tremendous strain on the framework. 
So here we need to make the beam move and we need to destroy it when we're done with it.
1. Add a repeat until <   > block from the Control tab to the end of our when I start as a clone block.
2. We're going to delete the sprite once it reaches the end of the screen, but until then we're going to move it. Add a [  ] > [  ] block found in the Operators tab to our repeat until block.
3. Click on the Motion tab and grab x position and put it as the first parameter of our [  ] > [  ] block. Add 240 (which is the edge of the screen) as the second parameter. 
4. Inside the repeat, we want to keep moving toward the edge of the screen. From the Motion tab, add a change x by 10 block inside of the repeat until block.
5. At the bottom of this script we want to delete this clone. It will have reached the end of the screen and done everything we want it to do! Go to the Control tab and add a delete this clone block to the end of the when I start as a clone block.
6. It's a little strange that there is a spare Paddle sprite sitting on the screen. If you click the little (i) in the corner of the sprite you can see a dialog where you can uncheck the show checkbox. This will hide this sprite. Do the same for the Dragon sprite.
7. The problem is that when we clone a Prefab, the hidden attribute is also cloned. We need to add a show block from the Looks tab to our when I start as a clone block. I would do this directly before the repeat until block. 
You should have something that looks like this:
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At this point Scratchy can fly around and shoot! All we need is our Dragon!


Step 4 – Enter the Dragon!
We're just one Dragon short of a playable game! The tricky part is that there isn't an "action" per se that we can trigger the spawning of the opponent. We're going to handle this by creating a "enemy spawn" loop.
1. Select the Dragon sprite from the sprite list.
2. Go to the Events tab and grab a when (flag) clicked block and pull it onto the Dragon's script area.
3. Add the same repeat until [GameOver] = [1] block sequence as we have under the main game loop on the Scratchy sprite. 
4. Depending on the level, we want to spawn opponents faster or slower. For this, we're going to need a Level variable. Create one! Go ahead and leave it on the screen, but it will probably need some adjusting.
5. Add a wait block. For the time add the formula: ((11 – Level) * 0.2) secs. This basically says that as the level increases, the amount of time we wait to spawn the next opponent lessens. 
6. From the Control tab, add a create spawn of myself block inside of the repeat until block.
7. Now we need  way to level up! Let's say that every 10 * Level Kills deserves a level up! In order to track this we're going to need a Kills variable. Let's not show it (I'll explain later) on the screen by making sure the checkbox next to the variable.
8. While we're there, let's add a Lives variable that we'll use soon. You probably do want to display this one.
9. Add an if <    > then block that we'll use to do our level-up.
10. Inside of the if block add the following formula: ((Kills) mod (10 * Level)) = (0). This formula basically says that for every 10 * Level kills, we level up. So after 10 kills we go to Level 2. After 20 we get to Level 3.
11. Add a change Level by 1 block inside of the if block.
12. This may sound odd, but we're going to need to increment our kills here. If we don't then the entire time we're on the 10th dragon and before they user kills the 11th the levels will ramp up fast! If we add a kill right off the bat (a freebee) then it won't do this. So add a change Kills by 1 block as well.
13. I also like to wait a couple of seconds between levels. If you like, add a wait 3 secs in this if then statement as well. 
So now the dragons will spawn but they don't do anything themselves yet! We want to start them out in random places, and at random scale, and with random speed, and in a random color.
1. Under the Control tab, add a when I start as a clone block to the Dragon script area.
2. Add a set x to (300) block from the Motion tab.
3. We want our y value to be randomly generated. To do that we start with a simple set y to (   ) block. Drag that below the set x to block.
4. Under the Operators tab, use the pick a random (-180) to (180) block and put it inside the parameter for the set y to block.
5. Add a set size to (pick a random (50) to (150)) % block
6. (Optional) Add a set color effect to (pick a random (0) to (200))
7. We need to create one last variable. This one is a little different though. We need to create this variable in such a way that it's not shared between any other object (or even between copies of itself) because it's going to hold our velocity which will be calculated randomly.
a. Create a variable named Velocity. Make sure the For this sprite only radio button is selected.
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8. Add a set Velocity to (pick a random (-5) to (-10 * Level)) block.
9. Add a show block from the Costumes tab.
10. Add a repeat until <   > block from the Control tab.
11. Add the parameter (x position) < (-260) to the repeat until block.
12. Add a move (Velocity) steps block from the Motion tab.
13. Add a wait (0.05) secs block from the Control tab.
14. We need to work on hit detection. If the laser touches us then this is called a collision. Collision detection is one of the main functions of a game engine. In scratch this is really easily done with the <touching [   ]> block under the sensing tab. Add a if <touching [Paddle]> then block.
a. When we get hit there are just two things that we need to do. The first is increment the Kills variable by adding a change [Kills] by 1 block.
b. The other is we need to kill this Dragon! All we need to do for that is add a delete this clone block from the Control tab.
15. To finish this block, add a delete this clone block from the Control tab. This will delete any dragons that didn't get shot down.
One last touch. We want the dragon to breath fire! We're going to do this by adding a bit of concurrent logic. This is a block that is the same trigger as another block but does something different at the same time (in parallel). 
1. Add another when I start as a clone block to the Dragon.
2. Add a forever block under it.
3. Add a wait (pick a random between (0.5) to (3)) block.
4. Add a next costume block from the Looks tab.
Before this all works, we need to initialize all of these variables we just added. Let's do this back at the main game loop on the Scratchy sprite.
1. Click on the Scratchy sprite to show the scripts for Scratchy
2. Add set Lives to 3.
3. Add set Level to 1.
4. Add set Kills to 1.
Now, if we've done this all correctly, we should have dragons spawning! If we've gotten everything done correctly, our Dragon code should look like this:
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Step 5 – Loosing Lives
At this point, if a dragon hits you nothing happens. We need to take away a life!
1. With the Scratchy selected, add another when (flag) clicked block. We do it here instead of our main game loop because we want our hit detection to be fast and our main loop has delays in it.
2. Add a forever block
3. Add a if <touching [Dragon]> then block
4. Add our custom Hit block inside.
Now all we need to do is define our hit block and we'll start loosing lives.
1. We want to allow a few seconds of invincibility. To do this we'll need a new variable. Create a variable called Invincible. Do not show it on the screen (uncheck the checkbox).
2. Add a block if <(GameOver) = (0) and (Invincible) = (0)> then to our Hit function.
3. Add a set [Invincible] to 0 block to our initialization section. 
4. Add a change [Lives] by –1 to our Hit block inside of our if statement.
5. We need a quick "you dead" check, so add an if [Lives] < 1 then block.
6. Add a set [GameOver] = 1 block inside the above if block.
7. Now we need to make ourselves invincible for the next few seconds.
a. Add set Invincible to 1.
b. Add set ghost effect to 50.
c. Add wait 3 seconds.
d. Add set ghost effect to 0.
e. Add set Invincible to 0.
You should have a block like this:
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The last thing we want to do is create a death scene. We'll switch costume and color and transparancy.
1. Add switch costume to [cat1 flying-b] to the Die custom block
2. Add set color effect to 100
3. Add set ghost effect to 75
4. Under the initialization section of our main loop, add switch costume to [cat1 flying-a]
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Step 5 – Sounds!
The game is much more fun with some sound! 
1. Under Scratchy, hit the Sounds tab and click the Choose Sound from Library button.
2. Under the Animal tab, select the Meow 2 sound.
3. Under the Effects tab, add the Bell Toll sound.
4. Under the Music Loops tab, add the Techno 2 sound.
5. Under the Paddle sprite, hit the Sounds tab and click the Choose Sound from Library button.
6. Under the Electronic tab, add the Laser 2 sound.
7. Under the Dragon sprite, hit the Sounds tab and click the Choose Sound from Library button.
8. Under the Effects tab, add the Fairy Dust sound.
9. In the Dragon Scripts, add a play sound [Fairy Dust] block, from the Sounds tab, right after the change Kills by 1 in the Spawn Loop.
10. In the Paddle Scripts, add a play sound [laser 2] right before the show block.
11. In the Scratch Scripts, add a play sound [meow 2] right before set Invincibility to 1 in the Hit function.
12. Add stop all sounds, and play sound [bell toll] to the Die function.
13. Last but not least is the music loop! 
a. Add a when (flag) clicked
b. Add repeat until <GameOver = 1>
c. Add play sound [techno2] until done
And we're done! Yay!

There are lots of other cool things we can add to our Game!
1. Other weapons
2. A high score screen
3. A score system
4. Other levels with other monsters 
5. Other backdrops
6. Etc.



Finished Game Code
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